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INTERMEDIATE INTRODUCTION

Course Description

This course covers the concepts and functionality you need to know in order to use the InEight
Estimate software successfully. As a result, you will be able to build cost estimates and bid proposals
with precision and efficiency.

Course Objectives

As a result of this course, you will be able to use the InEight Estimate software to:

l Review and report on project information

l Integrate with MS Excel and scheduling software (MS Project or Oracle Primavera)

l Manage quotes and use additional time-saving tools

How to Use this Manual

This training manual serves as the working guide during the E101 Essentials of Project Modeling and
Estimating instructor-led course. The first seven lessons of this document follow a natural progression
of putting an estimate together, from set up of a project to finalization of a bid. The remaining lessons
cover additional functionality that will help you build and review your project estimate more
effectively.

Lessons

The following lessons are covered in this course:



Course Lessons

Lesson Topic

Lesson 8 Quote Management

Lesson 9 Reporting

Lesson 10 Data Reproduction

Lesson 11 Excel Integration

Lesson 12 Schedule Integration

Lesson 13 Cash Flow

Lesson 14 InEight Estimate Calculators

Lesson 15 Cost Item Assemblies

Lesson Format

This manual is designed to be a “hands on” learning guide. As such, each lesson is organized into
sections:

Section Description

Objectives Specify what you will learn in each lesson.

Topics Organize the subject matter, with explanations of key concepts and terms.

Step by
Steps

Walk you through the “mechanics” of how to perform specific functions in the
software. For each step by step, you will use the Training Job that comes pre-
loaded in the InEight Estimate Estimating software.

Exercises Allow you to practice and reinforce what you learn. For each exercise, you will
use the Training Job that comes pre-loaded in the InEight Estimate Estimating
software.

Review Asks you questions to check what you have learned within each lesson.

Call-Outs

Throughout the document, you will also find important call-out banners.
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Tips are for important notes and information you want to remember.

Notes are for critical information you need to know.

Ongoing Use

This manual is also designed to be a comprehensive reference guide you can use outside of the
classroom and revisit as needed. Each lesson is compartmentalized so that you can refer back to each
lesson as needed.
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LESSON 2 — REPORTING

Lesson Duration: 30 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Run reports from the Reports menu

l Create and run reports from register forms

Lesson Topics



2.1 REPORTS MENU

InEight Estimate provides a lot of out of the box reports, referred to as “canned” or “system” reports,
that can help you review and analyze your estimate.

2.1.1 Non-Modal Report dialog box

The Reports dialog is docked along with the other forms and registers. You can continue to work with
your estimate without being forced to close the Reports dialog box.

If the report becomes undocked, the job code shows in the reports dialog box header.

2.1.2 Adjustable Reports

Most of the reports within InEight Estimate can be adjusted to output the specific data and reporting
format you need. Each report has its own set of output settings for configuring and formatting the
report.

All InEight Estimate adjustable reports are accessed from the Reports menu. You may even run the
same report multiple times and choose different output settings based on what you want to see or
who the intended audience is.
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For example, you may choose to run the CBS Details Report several times to satisfy different needs or
for different audiences, and include or exclude specific data depending on what you or the report
recipients want to see.

l For a group of estimators, you may want to run a CBS Details Report that shows all cost and
productivity data for a job

l For field personnel, you may want to run a CBS Details Report that shows no cost data, but all
production and resource data

l Finally, for executive management, you may want to run a CBS Details Report that shows
summary level information only

The following steps take you through a brief overview of the Reports menu and how you can access it.

Step by Step — Get to Know the Reports Menu

1. Open the Training Job, and select Setup tab.

l You access the Reports menu by clicking on the Reports icon

You can access the Reports menu from the Setup, Estimate, Quote, Price,
and Execution tabs.

2. Select Reports.

3. Here you select the Report of your choice. For this example, select the first option, Job
Properties.
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l You will see a split screen with the reports available on the left side bar

l The side bar on the left of the Reports form contains a “tree” of all InEight Estimate
adjustable reports
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l On the right, when you select a report node on the left, note that it displays the Output
Settings on the right side of the form, from which the report settings can be adjusted and
the report can then be run

4. Each report has a Print tab, a Layout tab and a Header/ Footer tab specific to that report.

l There are also Master Layout Settings and Master Header/Footer Settings located at the
bottom of the left-hand side bar tree. Here you can define settings that will apply to all
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reports

2.1.3 Output Settings

This section provides a more detailed explanation of the output setting tabs.

2.1.3.1 Report Printing Options

The Print tab includes three options for printing output: Print to Printer, Export to File, and Preview.
Export file outputs include PDF, Excel, text, and more.

Print Preview

The Reports print previews opens in its own tab in the Report Dialog. This lets you keep the report
open while continuing to use other parts of the application.
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You can also undock and float a report on a different form, or you can tile it side by side with another
register to view and compare them.
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Print Preview Ribbon

The Print Preview menu is displayed on its own ribbon. Menu commands are shown in the ribbon as a
contextual Print Preview menu when navigating to Reports > Print > Preview > Run.

2.1.3.2 Apply custom Layouts and Headers/Footers to register reports

You can apply custom Layouts and header/footers to register based reports. Upon saving a view in any
register, select the option to save it as a corporate view and include the view in the reports dialog box.
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When selecting a Saved View from the Reports register you can use the Print tab to customize the
printing preferences, use the Grid Options tab to change the font type/size, use the Layout tab to
modify the design style, and use the Header/Footer tab to insert a header and footer to your report.

When you click on the Run button it will create a new register-style report. You can modify the layout
or header/footer directly in this register. You can also toggle between any of the four other tabs to
make modifications and see the changes on the saved view report.
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2.1.3.3 Report Layout Settings

Many of the InEight Estimate adjustable reports include formatting options for the general layout of
the report, located under the Layout tab of the report’s output settings. Settings for the report include:
Orientation, Margins, Font, and Number Format.

Page 24 of 185 InEight Inc.  |  Release 2023

2.1 Reports Menu Estimate Intermediate User Guide



2.1.3.4 Report Header/Footer Settings

Many of the InEight Estimate adjustable reports include the option to define and insert headers and
footers into the report. You can add information to the left, middle, or right of the header and footer
sections of the report.

1. Once you define headers and footers, you can save them for use on other reports.

2. You can add page, time, and date stamps as needed, as well as images (e.g., company logo).

3. You can also use brackets to have it “stamp” the report with the Job Code and Job Description.
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4. You can enter your own information as desired.

Cover Sheet fields and Job folder tags

In addition to the existing job code and job description tags in Job Properties, you can use the Cover
Sheet fields and Job Folder tags for your headers and footers in all standard reports.

Additional tag values such as contract numbers, work order numbers, PO numbers, company logos, or
any other tag fields can also be included. These additions help you customize headers and footers to
give the recipients more transparency in the reports.
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A Header and Footer field menu exists to the left of the Page Header and Page Footer grid, for all
standard reports. This lets you choose which fields from Job Folder Tags and the Cover sheet to include
in your report.

You can customize your header and footer layout settings, save them, and re-use them in other
reports.

2.1.3.5 Report Detail Settings

Most reports have a Details tab with various options to configure what information is included on the
report.
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2.1.3.6 Save Output Settings

Once you’ve configured your settings for the report, you can save them as a custom version of that
report.
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The following steps walk you through configuring the settings and formatting for two different reports.
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Step by Step — Configure Report Output Settings (Report 1)

1. Open the Training Job and select Setup >Report>Resources.

2. Under Resources on the left side bar, select Resource Utilization.
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3. On the Print tab there are three options. A best practice is to always set to Preview so you can
review before printing.

4. On the Layout tab you can make adjustments based on your preferences.
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5. Move to the Header / Footer tab. Remove the default Report Title from the first page Header
only and enter Resource Utilization in the center Report Header box as a title that will appear on
the first page only.
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6. Go to the Details tab, and you can see the details and options you can select to customize and
adjust the report.

7. For this navigation, you will not Filter by currency; leave the selection as No Filter.

8. Under Report Type, choose the first option, Resource Utilization Summary.
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l You can choose to select the Hide Zero quantity/cost Resources Employments Details box
if you prefer to have your printed report not show any resources that have a dollar value
of zero

l You can choose if you want the report at a summary level, or if you want it to reference
your cost items when you are looking at a resource

l If you choose Resource Utilization Summary with Employed Cost Items, it adds CBS
position to the structure of the report

l You would select this if you wanted to see cost items and resources by the cost item

The Details settings are “sticky” features, meaning they default to what was
selected the last time.

9. You can use grouping to group by different tags and user-defined fields. Most of them are
related to the Resource Rate Register, for example: Geographic Area, Organizational Category,
Wage Zone, etc. For this example, group by Resource Organizational Category.

10. Next, you can choose the resources you want to see. For this example, select the Labor and
Construction Equipment Resource Types.
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l For this example, you will not make any selections under Columns or Details

l This is just one of many ways to organize and adjust your report.

11. Click Run to run the report.

l This report can be helpful for seeing your utilization hours, broken down by regular time
and overtime hours

12. Click the red X to close this page and open the Construction Equipment page.

13. Click the red X to close the Construction Equipment report.

Step by Step — Configure Report Output Settings (Report 2)

1. Open the Training Job and select Setup >Reports, then expand the Cost Breakdown Structure
node.
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2. Under Cost Breakdown Structure on the left side bar, select Estimate Summary.
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3. Along with the Print, Details, Layout, and Header / Footer tabs, there is an additional tab called
Cost Item Selection. Select this tab.

4. The Cost Item Selection tab allows you to report on a selection of cost items:

l Print a contiguous range of cost items:  Allows you to print a series of cost items in a row.
In this case, print just items: select 4.1 in the From field and 4.3.2 in the To field.

l Select cost items to print from the register below:  Allows you to use column filters to
select the cost items to include in the report; leave this button unselected.

5. You can roll up your cost items to a certain CBS level for the report as well, depending on the
level of detail you need.

6. On the Details tab, select Days for Cost item production field 1, andMan-Hours / UM for Cost
item production field 2 (this report allows you to report on two production values).

7. Under Resource Types, uncheck all of the boxes except Labor, ConstructionEquipment, and
Installed Material.
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8. Leave the rest of the settings at their defaults, then select the Header / Footer tab.

9. In the center Page Footer field delete the existing text, then type Confidential –Internal Use
Only.

10. To save the settings you’ve configured, click on the Settings drop-down arrow above the output
setting tabs.
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11. Select the Save disk icon to save the new settings.

12. Type Estimate Summary – Manager.

13. Click OK.

l Notice that a custom version of the report now displays under Estimate Summary on the
Reports tree on the left
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2.1.4 Helpful Reports

2.1.4.7 PBS Summary

Under the Price Breakdown Structure Report node, the PBS Summary Report gives a good overview of
how your price breaks down by cost category. This provides a high-level overview that is cost category
driven, providing information based on the total value of the project.

When selecting your settings on the Details tab, a best practice is to select and include:

l Cost Categories

l Markup Rate

l Percentage of Cost

This allows you to see your costs and markup broken out by cost category.
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You can also select to show markup rate and what percentage the markup is of your cost.

2.1.5 Standard Proposal

Located under the Pay Item & Proposal report node, the Standard Proposal report can be used for
contractors required to submit a pricing proposal to a client. It lists all the pay items with the client
provided quantities and your final pricing. You can include subtotals (defined on the Pay Item &
Proposal Register), cover sheet information, and a signature block.
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2.1.6 CBS Details

Under the Cost Breakdown Structure report node, the CBS Details report can be a helpful report for bid
review. On the Details tab you can include or not include any of the information contained in the CBS
Register, including cost items with production, costs by category, shift arrangements, resources, and
notes.
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2.1.7 Audit

Under the Job Tracking node, the Audit Report is a very important report to run during estimate review
to make sure you didn’t leave anything out of the estimate. It checks for a number of potential errors
in the estimate, including:

l Zero Price Pay Items

l Zero-value cost items

l Pay items without Cost Items assigned

l Resources with a quantity of zero
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Exercise 2.1 — Run a System Report

You can adjust InEight Estimate system reports to report on the particular information you need.
Complete the following steps to configure and run the Pay Item Summary report, using the Training
Job:

1. From the Reports window, expand the Pay Item & Proposal report node.

2. On the Reports tree, select Pay Item Summary.

3. On the Details tab, select a Pay Item Range from 303 4263 – 800 0220.

4. Choose to Include Assigned Cost Items.

5. Show Costs As: Unit.

6. Include Profit Analysis columns and Include Pay Item Price columns

7. Run the report.

You should end up with the following results
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Congratulations, you have completed this exercise!
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2.2 REGISTER REPORTS

At any time, you can print a report of the data in the currently displayed register using the Print or
Preview option available from the Actions tab for the register you are in.

The data that prints is the data currently displayed on the register form. The report will print whatever
columns are displayed on the register; if you have customized the display in the register, the report
prints that data. In other words, register reports are entirely customizable.

By creating Saved Views, you can report the data on a register form in several different variations.

The following step by step example will walk you through creating a custom register report on resource
utilization and saving it as a Saved View.

Page 46 of 185 InEight Inc.  |  Release 2023

2.2 Register Reports Estimate Intermediate User Guide



Step by Step — Create a Register Report

1. Open the Training Job and select Setup tab, then select the Resource Rates drop-down list.

2. From the drop-down list, select Labor.

3. From your Saved Views drop down menu on the Resource Rate Register, select the Print View
for Summary view.
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4. Notice this view includes utilization hours

5. Right-click on a column header and select Column Chooser.
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6. From the Customization window, drag-and-drop theMinority Percent, Unique Sales Tax, (Scale
2), andMaint. Man-Hour Factor columns into the register.

7. Close the Customize window.

8. Sort the Utilization Count column by clicking on the column header twice so that you see the
bars descending.

InEight Inc.  |  Release 2023 Page 49 of 185

Estimate Intermediate User Guide 2.2 Register Reports



l This sorts your items so the most utilized resources are at the top

9. Click on the Saved Views drop-down menu and select the Save disc icon to save the view.

10. Name the view Labor Utilization View, and then click OK to save the customized view.

11. From the Actionsmenu, select Preview to review the report before printing.
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2.2.1 Register Report Output Settings

Within the Preview for a register report, there are several options to choose from to configure the
output of your report.

2.2.1.1 Page Setup

While in the Preview mode, selecting File > Page Setup provides setup options for the page format:

l Page Size (legal, letter, etc.)

l Paper Width & Height

l Orientation (portrait or landscape)

l Page Margins (left, right, top, bottom)

2.2.1.2 Exporting to Document

Using the Export function allows you to identify a Print range, Image quality, Password Security, and
more. Selecting File > Export Document prints an Adobe Acrobat (*.pdf) report.
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Exercise 2.2 — Create a Custom Register Report

You can configure the columns in your registers for reporting and run your own custom reports.
Complete the following steps to configure and run a report from the CBS Register, using the Training
Job:

1. Select Estimate>Cost Breakdown Structure (CBS).

2. Under Saved Views, Select CBS Simple View.

3. Hide the Optional Code column.

4. Add back in theMan-Hours (Total) andMan-Hours / UM columns.

5. Now add back in the Labor Total Cost, Owned Equipment Total Cost, and Materials
Total Cost categories for reviewing the estimate.

6. Save the View (create your own name for the view).

7. Select Preview to view the report.

You should end up with the following results

Congratulations, you have completed this exercise!
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Lesson 2 Review

1. The ___________ Report gives a good overview of how your price breakdowns by cost
category.

a. Estimate Summary

b. PBS Summary

c. Audit

2. The ___________ Report is a very important report to run during bid review to make sure
you didn’t leave anything out of the estimate.

a. CBS Details

b. Audit

c. Pay Item Summary

3. A best practice is to always set your Print output setting to Preview so you can review
before printing.

a. True

b. False

Lesson 2 Summary

As a result of this lesson, you can:

l Run reports from the Report menu

l Create and run reports from register forms
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LESSON 3 — DATA REPRODUCTION

Lesson Duration: 20 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Create a job from an existing job or template

l Create a template

l Reproduce estimate data using the Bid Wizard

l Reproduce estimate data using copy/paste

l Add cost items to a job using the CBS Bid Wizard

l Utilize the Snapshot function

Lesson Topics



3.1 COPY AN EXISTING JOB

As you build an estimate, you may want to reuse pay items, cost items, or resources from a previous
estimate. When you plan to reuse the majority of content within a job, you can simply make a copy of
the existing job.

Using the Create a new Job from… Existing Job option on the Backstage View creates an exact replica
of the existing job, including the job’s properties, pay items, cost items, and resources.

The following Step by Step walks you through how to make a copy of an existing job.

Step by Step — Copy an Existing Job

1. Click the File tab on the Estimate landing page.

2. From the left side panel, select New, then select Existing Job.

3. The Job Register displays a list of your existing projects; select the Training Job and click OK.
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4. On the New Job dialog, in the Code field, type Infra Job Copy with your initials.

5. To copy the cost details from the existing job to the new job, verify that the Copy Cost Details
checkbox is selected

l If you wanted to copy just the cost item structure without cost details, you would uncheck
the box.

6. Uncheck the check for copying the PBS Changes Log.

7. Click OK to create the new job.

The new job opens with the Job Properties form active, so you can begin to modify the new job
as needed. If you look through the tabs on the Job Properties form, you will find that it looks
exactly like the job from which it was copied. Other forms, such as the Pay Item & Proposal
Register and the CBS Register, also look the same in both jobs until you make modifications in
one job or the other.

This is a very easy method for creating a new job, and it is a good choice if you want to copy an
entire job. However, if you want to pick and choose which parts of a job to duplicate, the Bid
Wizard is a better choice.

3.2 TEMPLATES

Job Templates provide you the ability to maintain a list of template jobs that can be used to create new
jobs. As your company grows and increases the number of projects, the need to standardize the
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estimating process increases to ensure consistency and reduce the chance of information being
overlooked.

In InEight Estimate you can create job folders and store them in a separate register as templates. This
allows you to store cost items in master templates separate from the jobs in your Job Register.

You can create templates from scratch or from existing job folders. The following steps walk you
through how to create a new template from an existing job folder.

Step by Step — Create a Template

1. Click the File tab on the Estimate landing page.

2. From the left side panel, select Templates.

3. Under Templates, select the Template Register.
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4. From the Actions tab, select Create Template from Job.

l The Job Register opens for you to select the source job for the template

l Assume that you want to make a template from your E101 Training Job

5. Select the E101 Training Job with your initials, then click OK.

You cannot create templates from jobs that are published to Job Tracking.
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l A prompt appears to give your new template a Job Code

6. In the Code field, type Small Project Template[your initials].

l Leave Copy Cost Details and Copy PBS Changes Log checked

7. Click OK.

l The new template is created and opens to the Job Properties form

l You can add the description in addition to the code for any new job you are creating from
a template. This description is later added to the Overview tab of the new job on the Job
Properties form

l Back in the Templates Register, you can see the new template created
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l Similar to copying an existing job, you can create a new job from a template
from the New menu in the Backstage View.

l You can also create a new job from a template from the New menu in the Bid
Wizard.

8. Select Add to existing job

9. From Select Source Job, click the dropdown arrow

10. Click Next

11. Select a job that is shown as having a Template

12. Click OK
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3.2.1 Archive and Restore Templates

The templates feature gives you the ability to archive and restore templates, enabling templates to
become portable. You can move templates between different environments. You can also backup the
templates similarly to the Jobs Archive and Restore function.

Step by Step — Archive and Restore a Template

1. Click File to open the Backstage View.

2. Select Archive / Restore.

l Several options appear for archiving and restoring your jobs, templates, and library

3. Select Archive Template.

l The Template Register appears

4. Select the Small Project Template [your initials] template you previously made, then click OK.

5. When prompted to include attachments, click Yes.

l The Save As window appears

6. Browse to where you want to save the job, then click Save.

7. Select Restore Template from the Archive / Restore page of the Backstage View to begin
restoring the template.

8. Browse to the archived template and select it.

9. Click Open.
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l If the template already exists, a prompt will appear asking if you want to overwrite it

l To overwrite it, select Yes

l If you select No, you will be prompted to save it under a new Template Code

3.3 BID WIZARD

InEight Estimate’s Bid Wizard is a powerful tool that can help automate the process of setting up
estimates by copying information that already exists in other InEight Estimate job folders. The Bid
Wizard can be used to create new projects, create a new job from an existing template, or to add to
projects that are already underway.

Rather than copying every part of an existing job, the Bid Wizard gives you more flexibility and control
over which parts of a job you want to duplicate, e.g., pay items or cost items or both.

In most cases you will be copying cost items, but if you have a project with pay items that are
commonly used, you can copy them into a new project. If you select pay items, you will be able to
select cost items as well.

The following Step by Step walks you through how you can use the Bid Wizard to create a new job by
importing pay items and their associated costs from an existing job.

Step by Step — Use the Bid Wizard

1. To open the Bid Wizard, click the File tab on the Estimate landing page.

2. From the left side panel, select New, then select Bid Wizard.
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l The Bid Wizard – Step 1 dialog displays

Notice that you can either create a new project or add to an existing project.

3. Type E101 Bid Wizard (with your initials) in the New Code field.

4. Type Bid Wizard Example in the Description field.

5. Click the Next button.

l The Bid Wizard – Step 2 dialog displays

6. Choose Select cost items and click Next.
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l The Bid Wizard – Step 3 of 4 dialog displays

l You use this step to indicate which source you want to pull your setup data from (the
library or your source job)

7. For all selections, select Copy from source job.

8. Check the Also copy all non-utilized resources checkbox.

9. Select Copy from source job under Unassigned Cost Items and Markup, and the Copy Markup
box is automatically selected.
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10. Click Next.

l The Bid Wizard – Step 4 of 4 dialog displays

11. Click the Source Job drop-down arrow.
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l The Job Register opens

12. Find and select Training Job.

13. Click OK.

l This screen displays the cost items of the source job (Training Job). All items are
automatically selected

14. Use the Toggle Include All button to exclude all selections.
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15. Select the checkboxes to includeMobilization, Clearing & Grubbing, and Unclassified
Excavation.

16. Notice that when selecting Unclassified Excavation, that cost item’s subordinates are
automatically selected
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17. Click Finish to add the new job.

l An Attention prompt appears asking, “Do you want to adjust Pay Rules and Shift
Arrangements of the copied cost items?”

l Typically, you will want to use the shifts and payment rules of your new destination job.

18. Select Adjust the pay rules and shift arrangements to match the destination.
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19. Click OK.

l A help bubble appears letting you know the job has been created, and that you can use
the ribbon tabs on the Estimate landing page to open any form

20. Close the help bubble by selecting the X in the upper right corner.

21. Open the Estimate > CBS to see the three cost items that were brought in.

Page 70 of 185 InEight Inc.  |  Release 2023

3.3 Bid Wizard Estimate Intermediate User Guide



3.3.1 Bid Wizard Updates

While using the Bid Wizard, the Include option is left unchecked by default. A filter is applied to bring
in pay items when using the Bid Wizard. The Toggle Include All button only selects the filtered list of
items instead of all items.

When the filter criteria is modified, the selected items remain checked even if some of the items might
not be visible in the view. When the view is changed, the selected items remain checked.

Tags and UDF fields are included in the Bid Wizard Selection register for the cost items and Pay Item &
Proposal selection registers. This lets you filter the list of cost items based on a tag or UDF.

When you select the Toggle Select All button, only filtered items are included which allow you to
include scopes of work relevant to your estimate without having to manually select all items needed.
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3.4 COPY ESTIMATE DATA USING EDIT COMMANDS

While the Bid Wizard is an efficient way to copy cost history into new projects, you may prefer to use
edit commands such as copy and paste to bring cost history into your estimate.

To copy and paste cost history from one job to another, it is beneficial to see the jobs side by side. The
following steps walk you through the process.

Step by Step — Copy Estimate Data Using Edit Commands

1. Click the File tab from the Estimate landing page and open the E101 Bid Wizard job you just
created.

2. Open the Training Job (if you do not still have it open).
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3. Make sure the CBS is open for both jobs by going to the Estimate menu and selecting Cost
Breakdown Structure (CBS).

4. Since you have both jobs open and they are in their own application window, align them to be
side by side by using theminimize icons of each job or utilizing Windows align functionality.
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l Note that the window caption identifies the CBS Register for each job

5. On the CBS of the Training Job, click the row header on cost item 4 – Aggregate Base and press
Ctrl+C to copy the cost item.

When you copy a superior cost item, all of its subordinates are automatically
copied.

6. On the CBS of the E101 Bid Wizard job, click the row header on the first blank register row, and
press Ctrl+V to paste the cost item.
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7. On the Attention dialog, select Adjust the pay rules and shift arrangements to match the
destination and click OK.

l You can see in the destination job’s CBS that you’ve added the Aggregate Base cost item,
along with its subordinate cost items and all cost and productivity detail

You can also drag and drop cost items from one CBS to another instead of
copying and pasting.

Copied cost items are considered Job Overhead until they are assigned to a
pay item

8. To go back to your full screen view of the E101 Bid Wizard job, select the maximize icon.
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3.5 CBS BID WIZARD

You can also use the Bid Wizard to add cost items while you are in the CBS Register. The following
steps walk through using the CBS Bid Wizard.

Step by Step — Use the CBS Bid Wizard

1. Click the File tab from the Estimate landing page and open the E101 Bid Wizard job you created.

2. From the Estimate tab, select Cost Breakdown Structure (CBS).

3. Create a new cost item by typing New in the Description column on the bottom row of the CBS

4. Highlight the New row.
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5. To open the CBS Bid Wizard, click the Bid Wizard icon on theMore Actions tab.

l The Bid Wizard window opens

6. Click in the Source Job column on the New cost item row.

7. From the Source Job drop-down list, select Training Job.

8. Scroll to the right of the Source Job column and click in the Source CBS Position Code column on
the New Cost item row.

l A source CBS Register window appears

9. Select CBS position code 5 – Asphalt Concrete Hot Mix Type A from the register.
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10. Click OK.

11. Click Finish on the Bid Wizard.

l An Attention prompt displays, asking if you want to make adjustments

l Keep the default options selected:Make Adjustments according to their quantity drivers
and cost drivers and Adjust the pay rules and shift arrangements to match the
destination

12. Click OK.

l You can see that cost item 5 and its subordinates are now imported into your existing job.

l You could choose a new name for the cost item, or name it Asphalt Concrete Hot Mix
Type A to match the original cost item
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3.6 SNAPSHOTS

A job snapshot is a copy of an estimate that provides read-only access to the job as it existed at a
specific point in time. You can now filter the Snapshot register to jobs containing snapshots.

The Snapshot register has some additional columns as well. In addition to the Code, Description, Last
Saved, and Version column, the Snapshot register contains all fields that are present on the Jobs
register that provides you with an easier way to group, sort, filter, and find the jobs you need.

3.6.1 Snapshot Register

The Snapshot Register is where you will view individual snapshots for specific jobs.

Step by Step — Snapshot Register

1. Click theFile tab to open the Backstage View. In the panel, select Snapshots.

2. From the Snapshots form, select the Snapshot Register tab.
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3. To view individual snapshots for specific jobs, click the icon next to the desired job to display
the list of snapshots.
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3.6.2 Creating a New Job Snapshot

Step by Step — Create a New Job Snapshot

You can create a Job Snapshot from an existing Job.

1. From the Snapshots form, select the Create Snapshot tab.

2. If an existing job is open select Save, if you haven’t already done so.
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3. A New Job Snapshot [Job Code Here] dialog box appears. From there, you can add a Snapshot
comment.

l If you want to Include all Attachments that have been stored in the Job Folder with this
Snapshot, select the check box, otherwise uncheck the box.

l If you want to Use Job's current User Access restrictions for this Snapshot, select this radio
button.

l If you want to Remove User Access restrictions for this Snapshot and allow read-only
access to all users, select this radio button

l If you want to Specify User Access restrictions for this Snapshot (default selection), select
this option

l Then use the Add and Remove buttons to specify user access using Active Directory.
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(Users with current access to the job default onto the list.)

4. Click OK to create the snapshot.

5. A pop-up indicates when the snapshot has been created.
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3.6.3 Editing a Job Snapshot

Step by Step — Edit a Job Snapshot

1. From the Snapshot Register, click the icon next to the desired job to display snapshots.

2. Right-click on the individual snapshot you want to edit and select Edit.

3. The same sort of dialog box opens up as when you created the Snapshot. In this case, from the
Edit Job Snapshot [Job Code Here] dialog box, modify the Snapshot Comment and the User
Access options as needed.

l If you want to Include all Attachments that have been stored in the Job Folder with this
Snapshot, select the check box. Otherwise, uncheck the box

l If you want to Use Job's current User Access restrictions for this Snapshot, select this radio
button

l If you want to Remove User Access restrictions for this Snapshot and allow read-only
access to all users, select this radio button

l If you want to Specify User Access restrictions for this Snapshot (default selection), select
this option

l Then use the Add and Remove buttons to specify user access using Active Directory.
(Users with current access to the job default onto the list.)

4. Click OK to update the snapshot.
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3.6.4 Deleting a Job Snapshot

Step by Step — Delete a Job Snapshot

1. From the Snapshot Register, click the icon next to the desired job to display snapshots.

2. Right-click on the individual snapshot you want to delete snapshots from and select
Delete.

3. Click OK

Alternatively, you can delete all Job Snapshots by clicking Delete All Job Snapshots from the
Actions tab.
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3.6.5 Loading a Job Snapshot

When you load an existing Snapshot, it loads into Estimate as any other job.

Step by Step — Load a Job Snapshot

1. Click the File tab to open the Backstage View, then select Snapshots.

2. From the Snapshots form, select the Snapshot Register tab.

3. On the Snapshot Register, click the icon next to the desired job to display the list of snapshots.

4. Right-click on the individual snapshot you want to load and select Load.
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To identify a snapshot in Estimate as a read-only snapshot:

l The job name is preceded by the label SNAPSHOT: centered on the top of the toolbar

l A red banner shows the specific snapshot information at the bottom of the screen

A snapshot can be modified, but it cannot be saved as it is read-only.
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Exercise 3.1 — Data Reproduction

Now that you have learned how to utilize the Bid Wizard, complete the following steps using the Bid
Wizard and Copy & Paste features.

1. Open the Bid Wizard by clicking the Bid Wizard icon from theMore Actions tab.

2. Choose the Create a new job radio button.

3. Type BW Exercise (with your initials) in the New Code field and type Exercise in the
Description field.

4. Choose Select cost items.

5. For all selections, choose Copy from source job.

6. Select the Also copy all non-utilized resources checkbox.

7. Select Copy from source job under Unassigned Cost Items and Markup, and the Copy
Markup box is automatically selected.

8. Find and select Training Job and click OK.

9. Use the Toggle Include All button to exclude all selections.

10. Select the checkboxes to include Cost Items 4-7.

11. Click Finish to add the new job.

12. Select Adjust the pay rules and shift arrangements to match the destination.

13. Open the CBS to see the cost items that were brought in.
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14. Open the Infra Job Copy with your initials that you created earlier in this lesson.

15. Copy Cost items 8 and 9 and paste them into the BW Exercise job.

You should end up with the following results

Congratulations, you have completed this exercise!

InEight Inc.  |  Release 2023 Page 89 of 185

Estimate Intermediate User Guide Exercise 3.1 — Data Reproduction



Lesson 3 Review

1. From the New option on the Backstage View, which of the following options are available
for creating a new job? (Select all that apply)

a. Scratch

b. Template

c. Import

d. Existing Job

e. Historic

f. Bid Wizard

2. Which of the following job reproduction options lets you pick and choose which cost
items you want to import into your new job?

a. Template

b. Bid Wizard

c. Existing Job

d. Archive

3. Which of the following options allows you to add cost items from another project when
working in the CBS Register?

a. Bid Wizard

b. CBS Bid Wizard

c. Template

d. Existing Job

Lesson 3 Summary

As a result of this lesson, you can:

l Create a job from an existing job or template

l Create a template
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l Reproduce estimate data using the Bid Wizard

l Reproduce estimate data using copy/paste

l Add cost items to a job using the CBS Bid Wizard

l Utilize the Snapshot function
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LESSON 4 — EXCEL INTEGRATION

Lesson Duration: 20 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Export data from InEight Estimate to Excel

l Link a field in InEight Estimate to Excel

l Update a linked InEight Estimate field with Excel data

Lesson Topics

4.1 EXPORT TO EXCEL

InEight Estimate's integration with Microsoft Excel includes a two-way integration that allows you to
update register fields in InEight Estimate with data contained in an Excel workbook, and update Excel
cells with data contained in a register column in InEight Estimate.

InEight Estimate includes a worksheet export that makes it easy to transfer data out of InEight Estimate
register forms to Microsoft Excel spreadsheets. This feature makes it faster and easier to send data
from an InEight Estimate register to a spreadsheet, analyze it, modify it, and customize it for any other
uses.

The Export to Excel feature is available on all register forms in the system and allows you to export the
data currently displayed on a register form to an Excel worksheet.



Step by Step — Export Data to an Excel Workbook

1. Open the Training Job and from the Estimate tab, open the CBS Register.

2. From the Actions tab, select Export to Excel.

3. On the Export spreadsheet to... dialog, browse to the location (folder) in your system where you
want to save the workbook, enter CBS Export in the File name field, and click Save.

l The workbook is saved to that location with the specified file name, and Excel
automatically launches and displays the workbook
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l Notice that the columns are formatted, with column headers and filtering turned on

4.1.1 Cell Select

To copy and paste data in InEight Estimate or to Excel, you can use a feature called Cell Select. Walk
through the following steps to learn how to copy specific fields in InEight Estimate to an Excel
Spreadsheet.

Step by Step — Cell Select

1. Open the Training Job and from the Setup tab, open the Resource Rate Register.

2. Select the Labor tab.

3. Select Print View for Summary from your Saved Views drop-down menu.

4. From the top-right corner, select the Cell Select icon, (next to the Help icon).
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l This puts you in “cell-select” mode, so you can select cells to copy in the same way you
would in Excel.

5. With the Cell Select icon active, highlight all information in the Description, Utilization Count
and Unit of Measurecolumns for all Labor resources.

6. Right click on the selection and select Copy.

7. Open an Excel spreadsheet, right click in the A1 field and select Paste Special, choosing CSV as
the Source.
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8. Click OK.

l The fields you copied from InEight Estimate paste into the spreadsheet

l To turn off the Cell Select, simply click the Cell Select Icon again and it deselects
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4.2 LINKING TO EXCEL

4.2.1 InEight Estimate Workbook

Every job has its own Excel workbook embedded within it for doing side calculations and take-offs. You
can link your calculations to fields in InEight Estimate to automatically update them into your estimate.
When you create a new job from scratch, the Library Master Workbook is copied to create a new
embedded Excel workbook for the job.

The workbook comes with some pre-defined take-off and analysis worksheets, or you can create your
own. Simply open the appropriate worksheet, plug in your values, and Excel will calculate your results.
To open your job’s workbook, select the Estimate tab, then click on the Workbook icon under the
Workbook section.
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l The embedded Excel workbook for the job opens.

4.2.2 Linking to and from Excel

InEight Estimate's linking capabilities with Excel can be done in one of two ways. A field in InEight
Estimate can be populated with a value from Excel, or a cell in Excel can be populated with the data
from an InEight Estimate field. This two-way linking functionality allows you to make quick work of
complex chores to perform spreadsheet-based take-off or formula-driven analysis.

The following example walks through how to link a simple take-off calculation into InEight Estimate
from Excel. It is a take-off to determine the size of a concrete foundation.
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Step by Step — Link Estimate to Excel

1. Open the Training Job and from the Estimate tab, open the CBS Register.

2. For this example, create a new cost item in the blank row at the bottom of the CBS register and
name it Concrete Foundation.

3. Open the job’s Excel workbook from the Estimate tab, by selecting the Workbook icon.

4. In the workbook, create a new worksheet named Concrete Take-off and enter the following
fields:

5. Create a new row to calculate the total cubic yards by factoring the length, width, and height
quantities.
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l Your Volume Total should be 50 cubic yards

6. InEight Estimate will only link to named fields in Excel. Click in the field you want to name (B6),
then click in the Field Name window and type Volume.

7. Go back to the CBS Register and right click on the Concrete Foundation cost item Forecast (T/O)
Quantity field.

8. From the resulting right click menu, select Link this field to Excel.

l You can also link the field by selecting the field and then selecting Link Field from the
Actions tab
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9. On the Link to Excel dialog, select the Update InEight Estimate field from Excel radio button.

10. In the Field to link window, select Volume (you may need to click the Refresh button for the
field name to display).
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11. Click OK.

l The Forecast Quantity field for Concrete now is linked to the Volume field in Excel and
populates with the take-off quantity (50)

4.2.3 Update Links

When data in InEight Estimate or Excel changes, you can quickly update all links, in just the currently
active job or in all open jobs.  Simply select one of the following options from the Workbook drop-
down list on the Estimate tab.
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Lesson 4 Review

1. The Export to Excel feature is available on all register forms in the system and allows you
to export the data currently displayed on a register form to an Excel worksheet.

a. True

b. False

2. In order to link an Excel field to InEight Estimate, the Excel field must be:

a. Named

b. Highlighted

c. Tagged

d. Selected

Lesson 4 Summary

As a result of this lesson, you can:

l Export data from InEight Estimate to Excel

l Link a field in InEight Estimate to Excel

l Update a linked InEight Estimate field with Excel data
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LESSON 5 — SCHEDULE INTEGRATION

Lesson Duration: 45 minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Set up scheduling options

l Update schedule from InEight Estimate

l Update InEight Estimate from schedule

l Manage changes between estimate and schedule

Lesson Topics



5.1 PRIMAVERA

5.1.1 Scheduling Options

Prior to sending information from InEight Estimate to Primavera, you need to make sure the proper
settings are in place.

5.1.1.1 Job Properties Schedule Tab

Primavera scheduling options are configured on the Setup > Job Properties > Schedule tab.

l At the top of the Schedule tab, the Integrated Schedule must be set to Primavera

l As a default, the Always use Plug Days when updating InEight Estimate from the schedule
checkbox is not selected (on a job by job basis, this box can be checked later for jobs in which an
estimator does not want updates from Primavera to change the duration and therefore the cost
of your cost items in InEight Estimate)

l On the Schedule tab, there are several sub-tabs that need to be set up correctly to produce
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correct data behavior and ensure the correct passing of data to Primavera

Step by Step — Login Options Tab

1. On the Schedule > Login Options tab of Job Properties, select the Use these login settings radio
button.

l If pre-defined login settings were required, the Use pre-defined login settings radio button
would be selected instead

l The Instance will remain set to -Default-

l Database selection will be pmdb during training.

2. Type your user name in the User Name field.

3. Type your password into the Password field.

l You will have your own login settings specific to your company
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5.1.1.2 Mapping Options Tab

The Mapping Options tab contains options critical to downstream applications. It will have the
following settings selected by default:

1. The CBS Position Code is selected as the field to populate the Primavera WBS Code and Activity
ID fields.

2. TheManage the Primavera WBS structure in InEight Estimate… radio button is selected for the
initial push from InEight Estimate to P6.

l This means the WBS structure in Primavera will be controlled by the structure of superior
and terminal cost items in InEight Estimate.

l Selecting the other option would cause the WBS structure to be controlled in Primavera.
Only terminal cost items would be sent from InEight Estimate to Primavera and all
hierarchal structure (WBS Elements) would be created in Primavera manually

l This option can be changed later, on a job-by-job basis.

3. The Update the Project’s Planned Start Date in Primavera from the Forecast Start Date option
is checked.

l This will automatically pull the Forecast Start Date from the Job Properties > Cover Sheet
tab to become the Planned Start Date in Primavera.

You should double-check to make sure the right Start Date is defined on the
Job Properties > Cover Sheet tab.

5.1.1.3 Resources Tab

The Resources tab dictates how resources are mapped between InEight Estimate and P6.
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Section Name

1 Update Primavera
Resources from Estimate

Provides options for sending InEight Estimate resources to
Primavera.

l Typically, you would select the Update scheduled
resources only option to send only resources that are
employed on cost items

l The Update all of this job’s resources option
updates Primavera with all of the resources in your
project’s Resource Rate Register

2 Map Resource Types to
Primavera

Specify whether your resources will import into Primavera
as Resources or Roles.

3 Update Primavera
Budgeted Units when
using Plug Days

Allows you to specify how to handle Budgeted Units for
items that use Plug Days.

4 Update Primavera Cost
Accounts from Estimate
Account Codes

Checking this box causes assigned account codes to
import into Primavera as Cost Accounts.

5 Update Price/Unit on
Primavera Resource
Assignments

Checking the boxes in this section will cause the Charge
Rate costs of your resources to import into Primavera along
with your resources.
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5.1.1.4 Overview – Resources Tab

5.1.1.5 Expense Costs Tab

The Expense Costs tab is useful for bringing costs in from InEight Estimate that are not connected to
resources, for example, your plugged and/or quoted cost items. This tab is optional, and it is not
required to make selections here.
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5.1.2 Schedule Cost Items

Before you can integrate with Primavera, your cost items need to be marked as Scheduled in InEight
Estimate. This is done on the Cost Breakdown Structure (CBS) Register. From your Saved Views drop-
down list in the CBS, the Schedule Setup View displays all of your schedule-related columns. There are
a couple to keep in mind when you schedule your items:

l Scheduled:  This column tells you which of your items are selected to be included in your
Primavera schedule

l Roll Up Schedule:  This column lets you check a box to roll up your estimate to the selected level
when it imports into Primavera

The following steps walk you through scheduling your cost items.

Step by Step — Schedule a Cost Item in InEight Estimate

1. In the Training Job, from the Estimate tab, select Cost Breakdown Structure.

2. In the Saved Views drop-down list, select Schedule Setup View.
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l In the Scheduled column, you can select the checkbox for each cost item that you want to
schedule

l If a cost item has subordinate cost items below it, you will only be able to check the
superior cost item, which will automatically schedule the subordinate cost items along
with it

3. Select theMobilization, Clearing & Grubbing, and Unclassified Excavation cost items, then
press Tab.

Step by Step — Schedule a Group of Cost Items in InEight Estimate

1. In the Training Job, from the Estimate tab, select Cost Breakdown Structure.

2. From the Saved Views drop-down list, select Schedule Setup View.

l To schedule multiple cost items, you can highlight the row for each cost item that you
want to schedule, using the Shift and Ctrl keys to select multiple rows.
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3. Select additional cost items 4-Aggregate base, 5- Asphalt Concrete Hot Mix, and 6- 36-inch RCP
Culvert Class.

To schedule all cost items, highlight the JOB row.

4. Right click on the selected rows and select Schedule Selection.

l On the Schedule Cost Items dialog, you can select whether or not you want to roll up the
selected cost items to a specific level of the CBS for scheduling purposes

5. Select Schedule selected cost items and their subordinates without rolling them up, then click
OK.
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l Your scheduled cost items will import into Primavera the next time you update Primavera
from InEight Estimate.

5.1.2.6 Roll Up Schedule

For cost item 3 – Unclassified Excavation, your scheduler does not need all of your estimate details and
wants to roll up your cost items to a higher level when they import into the Primavera schedule.

Follow the steps below to learn how to roll up your cost items for the schedule.

Step by Step — Roll Up Schedule

1. In the Training Job, from the Estimate tab select Cost Breakdown Structure.

2. From the Saved Views drop-down list, select Schedule Setup View.

l Review your cost items to decide which cost items need to be rolled up

3. Select the Roll Up Schedule checkbox on the Unclassified Excavation cost item.
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5.1.3 Update Primavera from InEight Estimate

Now that you have set up your Primavera options in Job Properties and scheduled your cost items in
the CBS, you are ready to send your project information to Primavera.

When you first update Primavera from InEight Estimate, Primavera will create a new project
automatically and load it with the following information from InEight Estimate:

Data Sent from InEight Estimate to Primavera

Data Type InEight Estimate Primavera

Project Data Job Code Project ID

Job Description Project Name

Activity Data CBS Position Code//Schedule ID WBS Code / Activity ID

Description WBS Element / Activity Name

Hours Planned Duration (Hours)

Shift and Rate Rules Activity Calendar

Cost Item Tags and UDFs Activity Codes or UDFs

Cost Category Total Cost Cost Category (custom text columns)
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Data Sent from InEight Estimate to Primavera

Resource Data Resource Code Resource ID

Resource Description Resource Name

Cost Data Resource Cost / Unit Resource Price / Unit

Cost Category Total Cost Expense Category Budgeted Cost

Tags, resource data, and cost data only update in Primavera if selected in the Job
Properties > Schedule settings.

The following steps walk you through updating Primavera from InEight Estimate to create a new
schedule.
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Step by Step — Update Primavera from InEight Estimate

1. From the Estimate tab, select Schedule>Update Primavera from InEight Estimate.

l The Update Primavera From Estimate dialog prompts you to indicate what data to update
to Primavera

2. Make sure Resources and Expenses are checked. Deselect Actuals (For Job Tracking purposes) if
auto selected, then click OK.
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l An Attention prompt appears, letting you know that the job has not been saved.

3. Click Yes to save the job before updating Primavera.

l A window appears that shows the progress of the data sync between InEight Estimate and
Primavera. Depending on the size of the job, this can take several minutes
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l When the window disappears, the update is complete

4. Open Primavera P6 (Project Management) client.

5. Log in to Primavera, using the same Username and Password that was entered on the Schedule >
Login Options tab in InEight Estimate Job Properties.
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6. In Primavera, open the project.
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7. In the Open Project dialog, expand the BID*BUILD folder.
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All projects created from InEight Estimate are created in the BID*BUILD folder by
default.

l Your available projects are sorted by their job names.

8. Select the Training Job (with your initials) so that it is highlighted, and then select Open.

l The WBS Layout displays for the project. You can see the breakdown structure imported
from InEight Estimate with durations, rolled up as specified by the Roll Up Schedule option
in InEight Estimate

l Initially, the start date for your activities is the start date defined on the Job Properties >
Cover Sheet tab (these will change as activity relationships are defined)

9. Select the Resources tab to see the resources that imported for each activity, with their
associated costs.
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5.1.4 Update InEight Estimate from Primavera

You can also bring information back from Primavera into InEight Estimate. When you update InEight
Estimate from Primavera, the following information updates:

Update InEight Estimate from Primavera

Data Type Primavera InEight Estimate

Activity Data Start Dates Start Dates

Finish Dates Finish Dates

Relationships Schedule Relationships

Hours Plugged Days
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Complete the following steps to practice updating InEight Estimate from Primavera. You will create a
scheduling relationship in Primavera, and then import the updated dates and relationships into InEight
Estimate.

Step by Step — Update InEight Estimate from Primavera

1. Open your version of the Training Job project in Primavera.

l In the real world, it is likely that you would have overlapping activities, or your activities
would occur out of order, however for this example you will link all activities from finish to
start

2. Highlight all of your activities from 1-Mobilization through 6.4-Backfill RCP Pipe.

3. Right click on one of the selected rows and select Link Selected Activities to create the Finish to
Start relationship.

l You may have to select the Relationship Lines button to show the linked activities in the
graph on the right side of the screen.

4. To schedule this new relationship, select the Schedule button (or press the F9 key).

5. On the Schedule Project window, keep the default settings and select the Schedule button.
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6. To update InEight Estimate with this change, go back to InEight Estimate and select Estimate tab.

7. Select Schedule>Update Estimate from Primavera.

8. On the Update InEight Estimate from Primavera prompt, keep the default Update the estimate
to stay in synch with the schedule selected, then click OK.
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9. On the Schedule Setup View, you can see the Start and Finish dates updated from Primavera.
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5.1.5 Manage Changes Between Estimate and Schedule

As changes to scope, resources, and costs come up in your estimate, and changes to relationships and
dates occur in the schedule, you can continue updating your estimate and schedule as needed.

5.1.5.7 Plug Days

The Schedule Plug Days option allows you to define the duration in the schedule separate from the
duration defined for your cost items on the Production tab.

For example, your 10” PVC Pipe activity may have extra days in the schedule due to the delivery date
of the pipe material, but you don’t want those extra days to drive the costs in your estimate, since your
crews won’t be working on the activity on those extra days.

All superior cost items are hard-coded to use Schedule Plug Days.

Step by Step — Schedule Plug Days

1. Look at the Days (Duration driven) column in the CBS where it shows 4.65 days for Excavate-
Install-Backfill Pipe.

2. Make sure the Schedule Plug Days checkbox is selected on the Excavate-Install-Backfill Pipe
cost item, then enter a Plug Days duration for the number of days the item will be scheduled in
Primavera (7 days).

l This allows you to maintain your duration of 4.65 days in the estimate and 7 days in the
schedule.

5.1.5.8 Update Primavera with InEight Estimate Changes

The following steps will walk you through updating the schedule with a scope change in your estimate.
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Step by Step — Update Primavera with InEight Estimate Changes

1. In the Training Job from the Estimate tab, select Cost Breakdown Structure.

l In this scenario, there is a scope change for your Excavation requiring you to change all of
your quantities

2. Change the quantity in the Forecast (T/O) Quantity field in the CBS as specified below:

Quantity Change for Cost Item

CBS Code Description Old Quantity New Quantity

5 Asphalt Concrete Hot Mix Type A 35,000 25,000

l As you make your changes, take note of how your duration changes in the Days (Duration
driven) column for these items

l If prompted about changing Total or Unit Cost, select Change TOTAL cost, so that your unit
costs stay intact, then click OK.

3. From the Estimate tab, select Schedule>Update Primaverafrom InEight Estimate to send the
changed hours to Primavera.
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l The Update Primavera From InEight Estimate dialog prompts you to indicate what data to
update to Primavera

4. Make sure Resources and Expenses are checked, then select OK.

l A window appears that shows the progress of the data sync between InEight Estimate and
Primavera. Depending on the size of the job, this can take a few minutes
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l When the window disappears, the update is complete

5. Open Primavera (P6 Web Client).

6. Open the Training Job project.

7. On the Activities screen, compare the Planned Duration to the Days (Duration driven) in InEight
Estimate for Excavate-Install-Backfill Pipe.

l The Primavera scheduled duration should have changed from 4.65 days to 7 days to match
the updated duration in InEight Estimate for Excavate-Install-Backfill Pipe

l You will also notice a change in days for Excavation after changing the T/O Quantity in
InEight Estimate
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8. To schedule this change in Primavera, select the Schedule button (or press the F9 key) and select
the Schedule button on the Schedule Project window.

9. Your start and finish dates are different now. In InEight Estimate, from the Estimate tab, select
Schedule>Update InEight Estimate from Primavera to update InEight Estimate with the new
dates.
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Exercise 5.1 — Manage Changes Between Estimate and Primavera

As changes occur during the estimating process, you can keep the estimate and schedule in sync
through schedule integration. In this exercise, you will practice making changes between the
estimate and schedule. Complete the following steps:

1. Open the Training Job and open the CBS Register.

2. Check the box in the Schedule Plug Days column for the Install RCP Pipe.

3. Change the Plug Days for Install RCP Pipe to 8 days.

4. Update Primavera from InEight Estimate.

5. Open the Training Job project in Primavera and confirm the Planned Duration (you may
need to change your view to see this column) changed to 8 days.

6. In Primavera, change the Planned Duration for Backfill RCP Pipe to 12 days.

7. Schedule the changes in Primavera (Schedule button or F9).

8. Update InEight Estimate from Primavera.

You should end up with the following results

Cost item 6.3 Install RCP Pipe is now showing 8 Plug days in Primavera.
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Cost item 6.4 Backfill RCP Pipe should have 12 plug days in InEight Estimate.

Congratulations, you have completed this exercise!
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5.2 MICROSOFT PROJECT

5.2.1 Set Up Scheduling Options

Prior to sending information from InEight Estimate to Microsoft Project, you need to make sure the
proper settings are in place.

5.2.1.1 Job Properties Schedule Tab

Microsoft Project scheduling options are configured on the Schedule tab of the Job Properties form.

l At the top of the Schedule tab, the Integrated Schedule must be set toMicrosoft Project

l As a default, the Always use Plug Days when updating InEight Estimate from the schedule
checkbox is not selected (on a job by job basis, this box can be checked later for jobs in which an
estimator does not want updates from Microsoft Project to change the duration and therefore
the cost of your cost items in InEight Estimate)

5.2.2 Schedule Cost Items

Before you can integrate with Microsoft Project, your cost items need to be marked as Scheduled in
InEight Estimate. This is done on the Cost Breakdown Structure (CBS) Register. From your Saved Views
drop-down list in the CBS, the Schedule Setup View displays all of your schedule-related columns.
There are a couple to keep in mind when you schedule your items:
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l Scheduled:  This column tells you which of your items are selected to be included in your
Primavera schedule

l Roll Up Schedule:  This column lets you check a box to roll up your estimate to the selected level
when it imports into Primavera

In the below example, notice that all of the cost items are scheduled, but the subordinates for
Unclassified Excavation will be rolled up to the superior level.

The following steps walk you through scheduling your cost items.

Step by Step — Schedule a Cost Item in InEight Estimate

1. In the Training Job, from the Estimate tab, select Cost Breakdown Structure.

2. In the Saved Views drop-down list, select Schedule Setup View.

l In the Scheduled column, you can select the checkbox for each cost item that you want to
schedule

l If a cost item has subordinate cost items below it, you will only be able to check the
superior cost item, which will automatically schedule the subordinate cost items along
with it
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3. Select theMobilization, Clearing & Grubbing, and Unclassified Excavation cost items, then
press Tab.

Step by Step — Schedule a Group of Cost Items in InEight Estimate

1. In the Training Job, from the Estimate tab, select Cost Breakdown Structure.

2. From the Saved Views drop-down list, select Schedule Setup View.

l To schedule multiple cost items, you can highlight the row for each cost item that you
want to schedule, using the Shift and Ctrl keys to select multiple rows.

3. Select additional cost items 4-Aggregate base, 5- Asphalt Concrete Hot Mix, and 6- 36-inch RCP
Culvert Class.

To schedule all cost items, highlight the JOB row
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4. Right click on the selected rows and select Schedule Selection.

l On the Schedule Cost Items dialog, you can select whether or not you want to roll up the
selected cost items to a specific level of the CBS for scheduling purposes

5. Select Schedule selected cost items and their subordinates without rolling them up, then click
OK.

l Your scheduled cost items will import into Primavera the next time you update Primavera
from InEight Estimate.
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5.2.2.2 Roll Up Schedule

For cost item 3 – Unclassified Excavation, your scheduler does not need all of your estimate details and
wants to roll up your cost items to a higher level when they import into the Primavera schedule.

Follow the steps below to learn how to roll up your cost items for the schedule.

Step by Step — Roll Up Schedule

1. In the Training Job, from the Estimate tab select Cost Breakdown Structure.

2. From the Saved Views drop-down list, select Schedule Setup View.

l Review your cost items to decide which cost items need to be rolled up

3. Select the Roll Up Schedule checkbox on the Unclassified Excavation cost item.

5.2.3 Update Microsoft Project from InEight Estimate

Now that you have set up your schedule to integrate with Microsoft Project in Job Properties and
scheduled your cost items in the CBS, you are ready to send your project information to Microsoft
Project.

When you first update Microsoft Project from InEight Estimate, Microsoft Project will create a new
project automatically and load it with the following information from InEight Estimate:
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Data Sent from InEight Estimate to Microsoft Project

Data Type InEight Estimate Microsoft Project

Project Data Job Code Project Name

Activity Data CBS Position Code 01 – CBS Position Code

Description Description

Days (Duration Driven) Duration

Cost Data Cost Category Total Cost Cost Category (custom text columns)

The following steps walk you through updating Microsoft Project from InEight Estimate to create a new
schedule.

Step by Step — Update MS Project from InEight Estimate

1. From the Estimate tab, select Schedule>Update Project from InEight Estimate.

l Your job automatically opens in Microsoft Project

l The Work Breakdown Structure Layout displays for the project
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l You can see the breakdown structure imported from InEight Estimate with durations,
rolled up as specified by the Roll Up Schedule option in InEight Estimate

l Initially, the start date for your activities is the start date defined on the Job Properties >
Cover Sheet tab (these will change as activity relationships are defined)

5.2.4 Update InEight Estimate from Microsoft Project

You can also bring information back from Microsoft Project into InEight Estimate. When you update
InEight Estimate from Microsoft Project, the following information updates:

Update InEight Estimate from Microsoft Project

Data Type Microsoft Project InEight Estimate

Activity Data Start Dates Start Dates

Finish Dates Finish Dates

Hours Hours
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Walk through the following steps to practice updating InEight Estimate from Microsoft Project. You will
create a scheduling relationship in Microsoft Project and then import the updated dates and
relationships into InEight Estimate.

Step by Step — Update InEight Estimate from MS Project

1. Open your version of the Training Job project in Microsoft Project.

l In the real world, it is likely that you would have overlapping activities or your activities
would be out of order, however for this example you will link all activities from finish to
start

2. Click on the Link Tasks icon to link all activities.

l Ensure the Auto Schedule button is selected

3. To update InEight Estimate with this change, go back to InEight Estimate and from the Estimate
tab, select Schedule>Update InEight Estimate from Project.
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l On the Schedule Setup View, you can see the Start and Finish dates updated from MS
Project.

5.2.5 Export Copy of MS Project File

If your project’s schedule is integrated with MS Project, you can export a copy of your MS Project file.
This can be advantageous if a preliminary schedule is needed for a starting point schedule, as the
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project goes into execution. Recreating the schedule from scratch can be time consuming and error
prone, as the existing schedule details might not be properly captured in the beginning stages.

5.2.6 Manage Changes Between Estimate and Schedule

As changes to scope, resources, and costs come up in your estimate, and changes to relationships and
dates occur in the schedule, you can continue updating your estimate and schedule as needed.

5.2.6.3 Plug Days

The Schedule Plug Days option allows you to define the duration in the schedule separate from the
duration defined for your cost items on the Production tab. For example, your 10” PVC Pipe activity
may have extra days in the schedule due to the delivery date of the pipe material, but you don’t want
those extra days to drive the costs in your estimate, since your crews won’t be working on the activity
on those extra days.

All superior cost items are hard-coded to use Schedule Plug Days.
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Step by Step — Schedule Plug Days

1. Look at the Days (Duration driven) column in the CBS where it shows 4.65 days for Excavate RCP
Trench.

2. Make sure the Schedule Plug Days checkbox is selected on the Excavate RCP Trench cost item,
and then enter a Plug Days duration for the number of days the item will be scheduled in
Primavera (7 days).

l This allows you to maintain your duration of 4.65 days in the estimate and 7 days in the
schedule.

Any duration changes made in Project will import into InEight Estimate as Plug Days
automatically so that they can be reviewed by the estimator before making any changes to
production in InEight Estimate.

5.2.6.4 Update Microsoft Project with InEight Estimate Changes

The following steps will walk you through updating the schedule with a scope change in your estimate.

Step by Step — Update MS Project with InEight Estimate Changes

1. In the InEight Estimate Training Job, from the Estimate tab, select Cost Breakdown Structure.

l In this scenario, there is a scope change for your Excavation requiring you to change all of
your quantities

2. Change the quantity in the Forecast (T/O) Quantity field in the CBS as specified below.
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Quantity Change for Cost Item

CBS Code Description Old Quantity New Quantity

5 Asphalt Concrete Hot Mix Type A 35,000 25,000

l As you make your changes, take note of how your duration changes in the Days (Duration
driven) column for these items.

l If prompted about changing Total or Unit Cost, select Change TOTAL cost, so that your unit
costs stay intact

3. From the Estimate tab, select Schedule>Update Projectfrom InEight Estimate to send the
changed hours to Microsoft Project.

4. Go back to the Training Job in Microsoft Project.

l The Microsoft Project scheduled duration should have changed from 4.65 days to 7 days to
match the updated duration in InEight Estimate for Excavate RCP Trench

l You can also see that the days for Asphalt Concrete Hot Mix Type A and its subordinates
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adjusted because you adjusted the Forecast T/O Quantity in InEight Estimate

5. Your Start and Finish dates are different now. In InEight Estimate, from the Estimate tab, select
Schedule >Update InEight Estimate from Project to update InEight Estimate with the new dates.
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Lesson 5 Review

1. Under the Job Properties > Schedule tab, which setting can be enabled to account for
plugged costs (e.g., for subcontractors)?

a. Resource price/unit

b. Expense Costs

c. Schedule ID

d. Actuals

2. For InEight Estimate schedule integration with Primavera, which of the following can be
sent from your estimate to the schedule? (Select all that apply)

a. Activity data

b. Cash Flow graphs

c. Resource data

d. Cost data

e. Price data

3. The Schedule Plug Days option allows you to define the duration in the schedule separate
from the duration defined for your cost items on the Production tab.

a. True

b. False

Lesson 5 Summary

As a result of this lesson, you can:

l Set up scheduling options

l Update Schedule from InEight Estimate

l Update InEight Estimate from Schedule

l Manage changes between estimate and schedule
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LESSON 6 — CASH FLOW

Lesson Duration: 25 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Interpret cash flow and resource utilization on the Cash Flow graph

l Select Cash Flow Options

l Change Cash Flow Display Settings

Lesson Topics



6.1 CASH FLOW OVERVIEW

The Cash Flow form provides a graphical representation of the cash flow and resource utilization of
your project, so you can quickly assess financing and resource needs.

You can open the Cash Flow form by selecting the Estimate tab from the Estimate landing page, then
selecting Cash Flow from the Schedule section.

In order to generate a cash flow curve the estimate must be populated with schedule dates either
directly from integration with Primavera, Microsoft project, or input manually.

Section Description

1 The graph displays the projected cash flow of your project, along with job financing
expense, individual cost category costs and resource utilization.

l The x-axis measures time
l The left y-axis measures amounts
l The right y-axis measures quantities (when resource utilization is displayed)
l All graphs depicted on the Cash Flow form can be displayed based on Pay
Quantity or Forecast (T/O) Quantity

2 Click on the Display Settings icon to indicate what to display on the graph.
l You can display total costs and price or specific cost categories
l You can also set the display settings to report on Resource Utilization

3 Click on the Cash Flow Options icon to specify revenue timing, cost timing, and cost
of money.

4 Click the Excel icon to export the numerical data represented on the graph into an
Excel spreadsheet where you can run additional analysis.

5 You can filter the Cash Flow graph by date range or by a range of cost items.

6 Click and drag over the graph to zoom in on a particular section. Click the Reset
Zoom button to restore the graph to its original state.

Overview – Cash Flow Form
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6.2 CASH FLOW OPTIONS

The Cash Flow Options are used to define the cash flow rules (revenue timing, cost timing, cost of
money, and quantities) needed to calculate the finance expense and cash flow for your project.

Cash flow rules (revenue timing, cost timing, cost of money, and quantities) describe how cash flow
occurs between a contractor and a client, and between contractors or owners and
vendors/subcontractors. Cash flow is then calculated based on both the earning and payment terms
you specify, and the job's schedule and pay item prices.

To open the Cash Flow Options, click on the Cash Flow Options icon in the Tools section of the
Actions tab.

You can also access Cash Flow Options from the Setup > Job Properties > Cash Flow tab.
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1. Revenue timing:  Revenue is the amount of money actually paid to a contractor by the client for
the completion of project deliverables. This section contains options to specify when and how
often payment is recieved.

2. Cost Timing:  Cost is the amount of money expended to complete the scope of the project. This
section contains options to specify when and how often you pay contractors, subcontractors and
vendors.

To include any of your costs in your cash flow (including indirect costs), they need
to be scheduled

3. Cost of Money:  Represents the financing cost to fund the project. This section contains fields to
specify interest rates you pay for the money you borrow, and interest rates you earn for money
invested, to determine a total Finance Cost.

4. Quantities: Allows you to calculate cash flow based on pay quantities or forecast (T/O)
quantities.

5. Dates: By default, the scheduled Early Start and Early Finish dates of each cost item (and its
resource employments) as listed in the CBS Register, provide the timing of the expenses,
revenue, and costs that show up on the Cash Flow graph. You have the option to base cash flow
timing on Start/Finish dates or Late Start/Finish dates.
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6.2.0.1 Cash Flow Options Set Up

The following steps walk you defining settings on the Cash Flow Options form.

Step by Step — Cash Flow Options Setup

1. In the E101 – Training Job, from the Estimate tab, select Setup >Job Properties >Cash Flow.

l You will see the default options already there

l You will adjust a few of those options

2. Change your Revenue timing to Every month on the 10th.
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l The average calendar days from billing to collection should be set to 25 days

3. For Cost timing, bills are received from subcontractors and vendors Every month on the 25th.

l Average calendar days elapsed from receipt of invoice to payment should be set to 30 days

4. For Cost of money, enter 10% for the Average annual interest rate paid to borrow money (when
cost exceeds revenue) and 2% for Average annual interest rate earned (when revenue exceeds
cost).

5. Leave all remaining options as originally defaulted.
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6.3 CASH FLOW DISPLAY SETTINGS

6.3.1

6.3.2 Cost Items and Cost Categories

The Cash Flow Display Settings allow you to control what information displays on the Cash Flow graph.
To open the Display Settings click on the Actions > Display Settings icon in the Tools section.

Section Description

1 You can save your display settings for future use.

2 Select how the graph measures the timing of your cash flow. Options include:  Day,
Week, Month, Quarter, and Year.

3 Under the Cost Items section, you can select:
l Total Cost (Forecast):  The total cost of your scheduled cost items, based on
when your costs are accrued (when your cost items are scheduled). This is
displayed as a dashed line on the graph

l Total Price (current):  The total revenue of your pay items, based on when the
revenue is earned (when your cost items are scheduled). This is displayed as
a dashed line on the graph

l Total Cost (Forecast) – Cash:  The total cost of your scheduled cost items,
reflecting the cost timing you specify in the Cash Flow Options. This is
displayed as a solid line on the graph

l Total Price (current) – Cash:  The total revenue of the pay items, reflecting the
revenue timing you specify in the Cash Flow Options. This is displayed as a
solid line on the graph

l Cash Flow:  Displays the difference between your Total Cost – Cash and Total
Price – Cash values, so you can see if you are making or losing money

l Finance Cost:  Displays the Cost of Money amount calculated from the
settings you specify in the Cash Flow Options

4 You can check the Estimated box for any specific cost categories you need to
display.

l The other check boxes are used for InEight Estimate Performance

Overview – Cash Flow Display Settings – Cost Items and Cost Categories
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6.3.2.1 Cash Flow Display Set Up

The following steps walk you through setting up your Cash Flow Display Settings.

Step by Step — Cash Flow Display Settings Set Up

1. In the E101 – Training Job, from the Estimate tab, select Cash Flow from the Schedule section.

2. On the Actions tab, select Display Settings to open the Display Settings window.

3. From the Period drop-down list, selectWeek.

4. Under the Cost Items section, make sure the following are selected:

l Total Cost (Forecast)

l Total Price (Forecast)

l Total Cost (Forecast) – Cash

l Total Price (Forecast) – Cash

l Cash Flow
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l Finance Cost

5. Under the Cost Categories section, check the Estimated checkbox for the Labor and Owned
Equipment categories.
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6. Click OK to close the Display Settings window.

l Your Total Cost (Forecast) displays as a dashed red line, indicating your accrued costs
based on when your cost items are scheduled and the assigned cost curves for each cost
item.

l Your Total Price (current) displays as a dashed green line, indicating the revenue you’ve
earned, based on the timing of your pay items

l Your Total Cost (Forecast) – Cash displays as a solid red line, indicating your costs, based
on when your cost items are scheduled and the cost timing defined in Cash Flow Options

l Your Total Price (current) – Cash displays as a solid green line, indicating your revenue,
based on the timing of your pay items and the revenue timing defined in Cash Flow
Options

l Your Cash Flow displays grey bars indicating when your cash flow is negative or positive
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l Your Finance Cost displays as a blue line on the graph

7. To filter your graph by date range, click on the Start drop-down arrow and select a start date of
your date range filter.

8. Click on the End drop-down arrow and select an end date of your date range filter.
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l Your graph now only includes your cost items that fall within the specified date range

9. To remove the filter, click in the Start field and press the Backspace key.

10. Do the same for the End field.

6.3.3 Resource Utilization

You can also use the Cash Flow graph to report on resource utilization. For example, you may want to
run a report that displays a work hours curve for a particular labor trade or to see the peak usage times
for a particular piece of heavy equipment.

You can run resource utilization graphs based off of any of the following:

l Resource Type

l Resource Code

l Description

l Organizational Category

l Tag 1, 2, and 3

l Quote Group

l Account Code and Cost Item Account Code

l Fuel Type

You set up your resource utilization settings from the same Display Settings window you use for setting
up Cash Flow, Display Settings in the Tools section of the Actions menu.
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6.3.3.2 Resource Utilization Display Set Up

The following steps walk you through setting up your Cash Flow graph to report on Resource
Utilization.

Step by Step — Resource Utilization Display Setup

1. In the E101 – Training Job, from the Estimate tab, select CashFlow from the Schedule section.

2. On the Actions tab, select Display Settings to open the Display Settings window.

3. Make sure the all checkboxes are unchecked under the Cost Items and Cost Categories sections.

4. Under the Resources section, check the Resource Utilization checkbox.

5. From the Summarize resources by drop-down list, select Description.

InEight Inc.  |  Release 2023 Page 163 of 185

Estimate Intermediate User Guide 6.3 Cash Flow Display Settings



6. From the resulting list of Values, select Laborer.

7. Click in the Qty field for the selected value and select a color of your choice.

l In this case the Qty represents the work hours for your Laborer resource

8. Click in the Cost field for the selected value and select a different color of your choice.

9. From the Quantity and Cost drop down lists, you can select how your quantities and costs will
display on the graph. In this case select the Quantity to display as a Bar and Cost to display as a
Line.

Page 164 of 185 InEight Inc.  |  Release 2023

6.3 Cash Flow Display Settings Estimate Intermediate User Guide



10. Click OK to close the Display Settings window.

l The graph now displays the utilization of your Laborer resource, showing the work hours
and costs used over time

The graphs displayed on the Cash Flow form are based on the estimated cost of each cost
item and its resource employments (in the case of resource utilization).
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Lesson 6 Review

1. Under what cash flow form can you set up your revenue and cost timing?

a. Cash Flow Options

b. Display Settings

c. Worksheet

d. Page Setup

2. By default, the red dashed line on the Cash Flow graph represents the:

a. Total Cost (Forecast)

b. Total Price (current)

c. Total Cost (Forecast) – Cash

d. Total Price (current) - Cash

3. In the Cash Flow Display Settings, Resource Utilization allows you to view a graphical
summarization of your resources by which of the following? (Select all that apply)

a. Resource File Description

b. Resource Type

c. Resource Code

d. Description

e. Wage Zone

f. Organizational Category

Lesson 6 Summary

As a result of this lesson, you can:

l Interpret cash flow and resource utilization on the Cash Flow graph

l Select Cash Flow Options

l Change Cash Flow Display Settings
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LESSON 7 — INEIGHT ESTIMATE
CALCULATORS

Lesson Duration: 20 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Use the Haul Calculator

l Use the Trench Calculator

l Use the In-Field Calculator

Lesson Topics



7.1 HAUL CALCULATOR

The Haul Calculator allows you to enter the specifics of up to three haul routes (distance, travel speed,
etc.). Once entered, you can either:

l Calculate the number of trucks required to complete the haul in a set amount of time, or

l Calculate how long it will take to complete the haul with a set number of trucks

The following activity walks step by step through using the Haul Calculator to calculate the number of
trucks needed for a cost item.

Step by Step — Haul Calculator – Calculate Quantity of Trucks

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

2. Open cost item 4.1 – Furnish & Haul Base Material.

3. On the Cost Item Record, click the Detail tab.

4. Right click on the ETDT – Dump Truck row header and select Open Haul Calculator.
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5. On the Haul Calculator, select the Calculate quantity of ETDT required to complete haul in
duration entered below radio button. (ETDT is the resource code for the Dump Truck you
selected.)

6. For the Haul Distance, type 5.

7. Enter an Average Payload (Ton) of 30.

8. For Load Time (Minutes), type 3.

9. Enter a Travel Speed Full of 35Mile/Hour.
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10. For Dump Time (Minutes), type 2.

11. Enter a Travel Speed Empty of 45 Mile/Hour. Notice this calculates a cycle time of 20.24.

12. Enter aWork Efficiency of 90 percent.
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l The calculator shows a result of 1.56 concurrent haulers

13. Click OK.

14. Your cost item now shows a quantity of 1.56. Round up the Quantity to 2. Also, adjust the
Teamster Quantity to 2 (if needed).

Step by Step — Haul Calculator – Calculate Total Duration

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

2. Open cost item 4.1 – Furnish & Haul Base Material.

3. On the Cost Item Record, click the Detail tab.

4. Change your Teamster and Dump Truck quantities back to 2 each.

5. Right click on the ETDT – Dump Truck row header and select Open Haul Calculator.

6. On the Haul Calculator, select the Calculate total duration of haul using quantity of ETDT
entered below radio button.

l With the previous information you entered still there, the calculator calculates a total
duration of 281.08 hours

InEight Inc.  |  Release 2023 Page 171 of 185

Estimate Intermediate User Guide 7.1 Haul Calculator



7. Click OK.

l The Hours field on the Production tab updated to 281.08

l Your ETDT Dump Truck quantity remains at 2

7.2 TRENCH CALCULATOR

The Trench Calculator allows you to quickly calculate trench, pipe, and bedding values. You can
perform pipe-related take-off by defining the details of the trench (e.g., length, depth, width, hinge
elevation, backslope, and swell factor), the pipe (diameter, elevation, and waste factor), and up to four
beddings.

With this information, the Trench Calculator can automatically calculate:

l Total excavation volume (neat-line)

l Total excavation volume (including swell/shrinkage)
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l Total pipe to purchase

l Lift Volume (for up to four beddings)

l Lift Weight (for up to four beddings)

You can use these calculations to define certain cost item setup data:

l You can use the Total Excavation Volume that is calculated as the quantity of the cost item

l You can use the Total pipe to purchase calculation as the quantity of a resource (e.g., pipe) that
has been employed to the cost item

l You can use the Lift Volume or Lift Weight that is calculated as the quantity of a resource
employed to the cost item in either cubic yards or tons

l You can click the Toggle English / Metric button at the bottom of the dialog to switch between
the English and Metric systems for entering data

You can access the Trench Calculator from the Actions tab of a Cost Item Record

When copying cost items in a job or from job to job, the Trench Calculator variable data is
included with the data being copied. When a cost item is copied to the clipboard, Trench
Calculator variable data is also included.

7.2.1 Trench Calculator – Trench Tab

The following steps walk through using the Trench Calculator to take-off excavation volume.

Step by Step — Trench Calculator – Trench

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

2. Create a new cost item from the bottom row of your CBS and call it 24” Pipe.

3. Add the following three subordinates and update their Units of Measure:

l Excavate Trench: CY

l Install Pipe: LF

l Backfill Trench: CY

4. Open the Excavate Trench Cost Item Record. Add the following resources:
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l LL2  Laborer – 1

l LO2  Operator Class 2 – 1

l EX245  Excavator 245 – 1

5. Adjust the Production to: 100 CY/Hour.

6. On the Cost Item Record’s Actions tab, select Trench Calculator.

7. For Trench Length, type 1000.00 feet.

8. For Trench Width (at the bottom) type 4.00 feet.

9. Enter a Trench Depth of 10.00 feet.

10. Enter a Hinge Elevation of 5.00 feet.
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11. Enter a Backslope of 45 degrees.

12. Define theMaterial Swell/Shrinkage Factor (fraction expressed as a decimal) at .10.

l You can select either a “neat-line” total volume or include swell/shrinkage

13. Select the “Total excavated volume (including swell/shrinkage)” checkbox.

14. Click Save Configuration to Library and save the Trench calculator as Trench Example with your
initials.

15. Click OK.

7.2.2 Trench Calculator – Pipe Tab

You can also use the Trench Calculator to take off how much piping and bedding you need for the
trench.
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Step by Step — Trench Calculator – Pipe

1. On the CBS Register, adjust the Forecast T/O Quantity for the Install Pipe cost item to 1000 LF.

l Assume this quantity is based off manual take-off calculations you already did

2. Open the Install Pipe Cost Item Record.

3. Add the Resource Assembly of CPIPE - Pipe Crew and adjust the production to 300 LF / Day.

4. On the Cost Item Record’s Actions tab, select Trench Calculator.

5. Select Load Configuration from Library.

6. Select Trench Example (with your initials).

7. Click OK.

8. On the Trench Calculator, select the Pipe tab.

9. Enter the following for the size and position of the pipe:

l Pipe exterior diameter:  26.00 inches

l Pipe center elevation (from bottom):  19.00 inches

l Waste factor: 10%

10. Click on the resource icon to pull up the Resource Rate Register.

11. Select the Installed Material tab.

12. SelectMPP24 Pipe 24” PVC SDR35, then click OK.

l The Pipe variables you entered should match the following image:

Page 176 of 185 InEight Inc.  |  Release 2023

7.2 Trench Calculator Estimate Intermediate User Guide



13. Click Save Configuration to Library and save the Trench calculator as Trench Example with your
initials.

14. When prompted to overwrite the existing saved file, click Yes.

15. Click OK to close the Trench Calculator.

7.2.3 Trench Calculator – Beddings Tab

The following steps walk you using the Trench Calculator to calculate bedding take-offs.

Step by Step — Trench Calculator – Beddings

1. Back on the CBS Register, adjust the Forecast T/O Quantity for Backfill Trench to 2300 CY, based
on manual calculations.

2. Open the Backfill Trench Cost Item Record.
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3. Add the following resources:

l LL2 Laborer – 3

l LO2 Operator Class 2 – 1

l RPC Plate Compactor – 1 

l EL950 Loader 950 – 1

4. Adjust the Production to 160 CY/Day.

5. From the Cost Item Record’s Actions tab, select Trench Calculator.

6. Select Load Configuration from Library

7. Select Trench Example (with your initials), then click OK.

8. On the Trench Calculator, select the Beddings tab.

9. On the Beddings tab, you can define up to four beddings to backfill the trench

l The variables you enter will determine how much bedding you need

10. Enter the following variables for each bedding:

Bedding Lift 1 Bedding Lift 2 Bedding Lift 3

Elevation (from trench floor) 6.00 38.00 76.00

Additional material needed 5.00 5.00 5.00

Conversion factor 1.60 1.70 1.60

l Under Results, you can match each of the Bedding Lifts with a material resource, by
selecting the resource icon and selecting the resource you want to employ from the
Material tab

11. Selecting the resource from the Tons selection field, select the following materials for each
bedding:

Resource Code Resource Description

Bedding Lift 1 MASAND Sand

Bedding Lift 2 MAFA Fine Aggregate

Bedding Lift 3 MACA1-1/2 Coarse Aggregate
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12. Click OK.

l Note that the pipe and bedding materials are added to the cost item with their quantities
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Exercise 7.1 — Trench Calculator

In this exercise, you will practice using the Trench Calculator to take-off piping and bedding
materials. Complete the following steps:

1. In the Training Job, create a new cost item called Underground Pipe.

2. Give the cost item a quantity and unit of measure of 1640 Linear Feet.

3. Open the new cost item and open the Trench Calculator.

4. On the Trench tab, enter the variables for the trench:

Trench length 1000 feet

Trench width (at bottom) 4 feet

Trench depth 10 feet

Hinge elevation 5 feet

Backslope 45 degrees

Material swell/shrinkage factor 0.10 (decimal)

l Do NOT check the box to bring in volume shrinkage.

5. Select theMPR36material resource from the drop-down Results list.

6. On the Beddings tab, enter bedding variables.

Bedding lift 1

Elevation (from trench floor) 6 inches

Additional material needed to compensate for compaction 5.00%

Conversions factor (Ton per CY) 1.3
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Bedding lift 1

Bedding material resource (Tons) MASAND

Bedding lift 2

Elevation (from trench floor) 38 inches

Additional material needed to compensate for compaction 5.00%

Conversions factor (Ton per CY) 1.1

Bedding material resource (Tons) MAFA

Bedding lift 3

Elevation (from trench floor) 76 inches

Additional material needed to compensate for compaction 5.00%

Conversions factor (Ton per CY) 1.1

Bedding material resource (Tons) MACA1-1/2

7. Select OK and confirm that the pipe material and bedding materials populated the cost
item.

You should end up with the following results
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Congratulations, you have completed this exercise!
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7.3 IN-FIELD CALCULATOR

You can use the In-field Calculator to do simple mathematical calculations in any numeric field on
records, registers, and tree lists. You use this calculator much like an Excel workbook field, by inserting
the cursor in the field where you want to perform a calculation, then pressing the "=" key, followed by
a valid arithmetic expression. To display the calculated result, you press the tab key. The resulting
value is stored without the arithmetic expression used to calculate the value.

The following steps walk through using the In-field Calculator to calculate the area of how much
sandblasting is needed for painting the steel bridge structure specified in the Training Job.

The resulting field value is stored without the arithmetic expression used to calculate the
value.

Step by Step — In-Field Calculator

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

2. Scroll to find cost item 13.3 Sandblast.

3. Click in the Forecast (T/O) Quantity field.

4. Press the = key, then type 10*250.
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5. Press the Tab key and it calculates the result.
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Lesson 7 Review

1. The Haul calculator allows you to:

a. Calculate the number of trucks required to complete the haul in a set amount of
time

b. Calculate how long it will take to complete the haul with a set number of trucks

c. Neither

d. Both

2. The Trench Calculator allows you to quickly calculate ___________ values.

a. Trench

b. Pipe

c. Bedding

d. All of the above

3. For the in-field calculator, what symbol needs to be at the beginning of the math
equation for it to calculate?

a. +

b. –

c. =

d. (

Lesson 7 Summary

As a result of this lesson, you can:

l Use the Haul Calculator

l Use the Trench Calculator

l Use the In-Field Calculator
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